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Paper Set 1 · 28 May 2026 · 9:00 AM - 10:30 AM · OSSSC CRE 2025 (Odia)

Quant

✓

Q1 Quant
ଏକ ସମଘନର ଧାର ଏକ ଆୟତଘନର ଉଚ୍ଚତା ଅପେକ୍ଷା 5 cm କମ୍  ଅଟେ । ଯଦି
ସମଘନର ସମଗ୍ର  ପୃ ଷ୍ଠ ତଳର କ୍ଷେତ୍ର ଫଳ 294 cm2 ହୁ ଏ, ତେବେ ଆୟତଘନର ଉଚ୍ଚତା
________ ଅଟେ ।

A.  7 cm

B.  9 cm

C.  12 cm

D.  15 cm

✓

Q2 Quant
A, B ଓ C ଏକ ବ୍ୟବସାୟରେ ଯଥାକ୍ର ମେ ₹50,000, ₹75,000 ଓ ₹1,25,000 ନି ବେଶ
କରନ୍ତି  । ଏକ ବର୍ଷ  ପରେ ମୋଟ ଲାଭ ₹1,00,000 ହୁ ଏ । B ଙ୍କ ଦ୍ୱାରା ପ୍ରା ପ୍ତ ଲାଭ ଅପେକ୍ଷା C
କେତେ ଅଧି କ ଲାଭ ପାଆନ୍ତି ?

A.  ₹15,000

B.  ₹20,000

C.  ₹30,000

D.  ₹35,000

✓

Q3 Quant
ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ପାତ ଗୁ ଡି କ ମଧ୍ୟରୁ  କେଉଁ ଟି  ବୃ ହତ୍ତମ ଅଟେ: 7:35, 12:29, 7:29 ଏବଂ
6:27?

A.  12:29

B.  7:35

C.  6:27

D.  7:29

✓

Q4 Quant
ଦୁ ଇଟି  କାର ଗୋଟି ଏ ସ୍ଥାନରୁ  ଆରମ୍ଭ ହୋଇ ବି ପରୀତ ଦି ଗରେ ଯାତ୍ରା  କରନ୍ତି  । ଯଦି  ଗୋଟି ଏ
କାର 43 km/hr ବେଗରେ ଏବଂ ଅନ୍ୟଟି  87 km/hr ବେଗରେ ଯାତ୍ରା  କରେ, ତେବେ 6
ଘଣ୍ଟା ପରେ ସେମାନଙ୍କ ମଧ୍ୟରେ ଦୂ ରତା କେତେ ହେବ?

A.  720 km

B.  780 km

C.  750 km

D.  760 km

✓

Q5 Quant
ଜଣେ ଦୋକାନୀ ₹60/kg ଏବଂ ₹90/kg ମୂ ଲ୍ୟର ଦୁ ଇ ପ୍ର କାରର ଚାଉଳକୁ  2 : 1
ଅନୁ ପାତରେ ମି ଶ୍ର ଣ କରନ୍ତି  । kg ପି ଛା ମି ଶ୍ର ଣର ମୂ ଲ୍ୟ କେତେ?

A.  ₹70

B.  ₹80

C.  ₹74

D.  ₹77

✓

Q6 Quant
ଯଦି  ଗୋଟି ଏ ସଂଖ୍ୟାର 40% ଅନ୍ୟ ଏକ ସଂଖ୍ୟାର ଦୁ ଇ-ତୃ ତୀୟାଂଶ ସହି ତ ସମାନ ହୁ ଏ,
ତେବେ ପ୍ର ଥମ ସଂଖ୍ୟା ଏବଂ ଦ୍ୱି ତୀୟ ସଂଖ୍ୟା ମଧ୍ୟରେ ଅନୁ ପାତ କେତେ?

A.  3:5

B.  5:9

C.  9:5

D.  5:3

✓

Q7 Quant
ଯଦି  ଏକ ଲାପଟପର ମୂ ଲ୍ୟ 12% ବୃ ଦ୍ଧି  ପାଏ ଏବଂ ପରେ 18% ବୃ ଦ୍ଧି  ପାଏ, ତେବେ ମୂ ଳ
ମୂ ଲ୍ୟଠାରୁ  ସାମଗ୍ରି  କ ପ୍ର ତି ଶତ ବୃ ଦ୍ଧି  କେତେ ଅଟେ?

A.  32.16%

B.  30%

C.  28.25%

D.  31%

✓

Q8 Quant
90516 ର କେଉଁ  ନି କଟତମ ସଂଖ୍ୟା 9 ଦ୍ୱାରା ବି ଭାଜ୍ୟ ହେବ?

A.  90509

B.  90513

C.  90518

D.  90521

✓

Q9 Quant
ଗୋଟି ଏ ସାର୍ଟ ର ଲି ଖି ତ ମୂ ଲ୍ୟ ₹1,200 ଅଟେ । ଜଣେ ଦୋକାନୀ ଏହା ଉପରେ 15% ରି ହାତି
ପ୍ର ଦାନ କରନ୍ତି  । ଗ୍ରା ହକ ଜଣକ କେତେ ମୂ ଲ୍ୟ ଦେବେ?

A.  ₹1,000

B.  ₹1,020

C.  ₹1,050

D.  ₹1,080
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✓

Q10 Quant
ପାଇପ M ଗୋଟି ଏ ଟାଙ୍କି କୁ  12 ଘଣ୍ଟାରେ ପୂ ର୍ଣ୍ଣ  କରି ପାରେ ଏବଂ ପାଇପ N ସେହି  ଟାଙ୍କି କୁ  24
ଘଣ୍ଟାରେ ପୂ ର୍ଣ୍ଣ  କରି ପାରେ । ଯଦି  ଉଭୟ ପାଇପ ଏକସାଙ୍ଗରେ ଖୋଲାଯାଏ, ତେବେ ଟାଙ୍କି
ପୂ ର୍ଣ୍ଣ  ହେବା ପାଇଁ  କେତେ ସମୟ ଲାଗି ବ?

A.  6 ଘଣ୍ଟା

B.  8 ଘଣ୍ଟା

C.  9 ଘଣ୍ଟା

D.  12 ଘଣ୍ଟା

✓

Q11 Quant
ସମାନ୍ତର ମଧ୍ୟକ ଠାରୁ  ହୋଇଥି ବା ସମସ୍ତ ପର୍ଯ୍ୟ ବେକ୍ଷଣର ବି ଚ୍ୟୁ ତି  (Deviations) ର
ସମଷ୍ଟି  ସର୍ବ ଦା ________ ଅଟେ ।

A.  ତଥ୍ୟ ଉପରେ ନି ର୍ଭ ର କରେ

B.  ଶୂ ନ

C.  ଧନାତ୍ମକ

D.  ନନ-ଜି ରୋ କନଷ୍ଟାଣ୍ଟ

✓

Q12 Quant
ଗୋଟି ଏ ଡଙ୍ଗା ସ୍ରୋ ତର ପ୍ର ତି କୂ ଳରେ 40 km ଦୂ ରତାକୁ  8 ଘଣ୍ଟାରେ ଅତି କ୍ର ମ କରେ । ଯଦି
ସ୍ଥି ର ଜଳରେ ଡଙ୍ଗାର ବେଗ 8 km/h ହୁ ଏ, ତେବେ ସ୍ରୋ ତର ବେଗ ନି ରୂ ପଣ କର ।

A.  2 km/h

B.  3 km/h

C.  4 km/h

D.  1 km/h

✓

Q13 Quant
ଗୋଟି ଏ ପାଇପ୍  ଗୋଟି ଏ ଟାଙ୍କି କୁ  12 ମି ନି ଟରେ ପୂ ର୍ଣ୍ଣ  କରି ପାରି ବ, ଯେତେବେଳେ ଅନ୍ୟ ଏକ
ପାଇପ ପୂ ର୍ଣ୍ଣ  ଟାଙ୍କି କୁ  24 ମି ନି ଟରେ ଖାଲି  କରି ପାରି ବ । ଯଦି  ଟାଙ୍କି  ଖାଲି  ଥି ବା ସମୟରେ
ଉଭୟ ପାଇପକୁ  ଏକାଠି  ଖୋଲାଯାଏ, ତେବେ ଟାଙ୍କି ର ଏକ ତୃ ତୀୟାଂଶ ପୂ ର୍ଣ୍ଣ  ହେବା ପାଇଁ
କେତେ ମି ନି ଟ ଲାଗି ବ?

A.  8

B.  16

C.  24

D.  32

✓

Q14 Quant
59036 ରେ କେଉଁ  କ୍ଷୁ ଦ୍ର ତମ ଗଣନ ସଂଖ୍ୟାକୁ  ଯୋଗ କଲେ ଯୋଗଫଳ 58 ଦ୍ୱାରା ସମ୍ପୂ ର୍ଣ୍ଣ
ବି ଭାଜ୍ୟ ହେବ?

A.  8

B.  5

C.  3

D.  12

✓

Q15 Quant
ଯଦି  ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ ସୁ ଧ ହାରରେ 2 ବର୍ଷ  ପାଇଁ  ସରଳ ସୁ ଧ ₹76 ଏବଂ ଚକ୍ର ବୃ ଦ୍ଧି  ସୁ ଧ ₹80
ହୁ ଏ, ତେବେ ମୂ ଳଧନ (₹ ରେ) କେତେ?

A.  361

B.  356

C.  354

D.  365

✓

Q16 Quant
ଗୋଟି ଏ ବୃ ତ୍ତ ଚାରି ପଟେ ଚତୁ ର୍ଭୁ ଜ ABCD ପରି ଲି ଖି ତ ହୁ ଏ । ଯଦି  AB = 6 cm., CD = 5
cm ଏବଂ AD = 7 cm ହୁ ଏ, ତେବେ ବାହୁ  BC ର ଦୈ ର୍ଘ୍ୟ  କେତେ?

A.  2 cm

B.  6 cm

C.  4 cm

D.  7 cm

✓

Q17 Quant
55 ର 30% ଅପେକ୍ଷା 50 ର 40% କେତେ ଅଧି କ ଅଟେ?

A.  3.5

B.  2.5

C.  4.5

D.  1.5

✓

Q18 Quant
ଏକ ରେଫ୍ରି  ଜରେଟରର ତାଲି କା ମୂ ଲ୍ୟ ₹75000 ଅଟେ । ଜଣେ ଖୁ ଚୁ ରା ବ୍ୟବସାୟୀ 10%
ଏବଂ 32% ର ଦୁ ଇଟି  କ୍ର ମି କ ରି ହାତି  ପାଇବା ପରେ ଏହାକୁ  କି ଣନ୍ତି  ଏବଂ ଏହା ତାଙ୍କର କ୍ର ୟ
ମୂ ଲ୍ୟ ହୋଇଯାଏ । ସେ ତାଙ୍କ କ୍ର ୟ ମୂ ଲ୍ୟ ଉପରେ 37% ଲାଭ ଅର୍ଜ ନ କରି ବାକୁ  ଚାହାଁ ନ୍ତି  ।
ଯଦି  ସେ ଗ୍ରା ହକମାନଙ୍କୁ  ତାଙ୍କର ଚି ହ୍ନି ତ ମୂ ଲ୍ୟ ଉପରେ 49% ରି ହାତି  ପ୍ର ଦାନ କରନ୍ତି , ତେବେ
ସେ ରେଫ୍ରି  ଜରେଟରକୁ  କେତେ ମୂ ଲ୍ୟରେ ଚି ହ୍ନଟ କରି ବା ଉଚି ତ?

A.  ₹123300

B.  ₹123289

C.  ₹123464

D.  ₹123294

✓

Q19 Quant
ଦୁ ଇଟି  କ୍ର ମି କ ଧନାତ୍ମକ ପୂ ର୍ଣ୍ଣ ସଂଖ୍ୟାର ଗୁ ଣଫଳ 870 ଅଟେ । ଯଦି  ସେହି  ଦୁ ଇଟି  ସଂଖ୍ୟା
ମଧ୍ୟରୁ  କ୍ଷୁ ଦ୍ର ତମ ସଂଖ୍ୟାଟି  x ହୁ ଏ, ତେବେ x ର ମାନ ନି ର୍ଣ୍ଣ ୟ କରି ବା ପାଇଁ  ନି ମ୍ନ ଲି ଖି ତ
ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  କେଉଁ  ସମୀକରଣଟି  ସଠି କ୍  ଅଟେ?

A.  x2 + x-870 = 0

B.  x2 + x + 870 = 0

C.  x2-x-870 = 0

D.  x2-x + 870 = 0

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q20 Quant
ଯଥାକ୍ର ମେ ବ୍ୟାସାର୍ଦ୍ଧ  'p' ଏବଂ 'q' ବି ଶି ଷ୍ଟ ଦୁ ଇଟି  ବୃ ତ୍ତ ପରସ୍ପରକୁ  ବାହ୍ୟ ଭାବରେ ସ୍ପର୍ଶ  କରନ୍ତି  । ମନେକର 'r' ହେଉଛି  ଏପରି  ଏକ ବୃ ତ୍ତର ବ୍ୟାସାର୍ଦ୍ଧ , ଯାହା ଏହି  ଦୁ ଇଟି  ବୃ ତ୍ତକୁ  ଏବଂ ସେମାନଙ୍କର
ଏକ ସାଧାରଣ ସ୍ପର୍ଶ କକୁ  ସ୍ପର୍ଶ  କରେ । p, q ଓ r ମଧ୍ୟରେ ସମ୍ପର୍କ  କ'ଣ?

A.  

B.  

C.  

D.  

GA

✓

Q21 GA
ଆଣ୍ଡାମାନ ଏବଂ ନି କୋବର ଦ୍ୱୀପପୁ ଞ୍ଜର ସର୍ବୋ ଚ୍ଚ ଶୃ ଙ୍ଗ, ସେଡେଲ ପି କ୍  (Saddle Peak)
ଦ୍ୱୀପପୁ ଞ୍ଜର କେଉଁ  ଅଂଶରେ ଅବସ୍ଥି ତ?

A.  ଉତ୍ତର ଆଣ୍ଡାମାନ

B.  ମଧ୍ୟ ଆଣ୍ଡାମାନ

C.  ଦକ୍ଷି ଣ ଆଣ୍ଡାମାନ

D.  ନି କୋବର ଦ୍ୱୀପପୁ ଞ୍ଜ

✓

Q22 GA
ବାଲ ଗଙ୍ଗାଧର ତି ଳକ ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ  ସ୍ଲୋ ଗାନ ଦେଇଥି ଲେ?

A.  "ସ୍ୱରାଜ ମୋର ଜନ୍ମ ଗତ ଅଧି କାର ଏବଂ ମୁଁ  ଏହାକୁ  ହାସଲ କରି ବି "

B.  "ଇନକି ଲାବ ଜି ନ୍ଦାବାଦ" 

C.  "କର ବା ମର" ଏବଂ "ଭାରତ ଛାଡ"

D.  "ବନ୍ଦେ ମାତରମ"

✓

Q23 GA
ନଭେମ୍ବର 2025 ରେ ଜାତୀୟ ଆଇନ ସେବା ପ୍ରା ଧି କରଣ (NALSA) ର କାର୍ଯ୍ୟ ନି ର୍ବା ହୀ
ଅଧ୍ୟକ୍ଷ ଭାବରେ କାହାକୁ  ନି ଯୁ କ୍ତ କରାଯାଇଥି ଲା?

A.  ଜଷ୍ଟି ସ୍  ହରି ଶ ଟଣ୍ଡନ

B.  ଜଷ୍ଟି ସ୍  ବି କ୍ର ମ ନାଥ

C.  ଜଷ୍ଟି ସ୍  ଅରୁ ଣ ପାଲ୍ଲୀ

D.  ଜଷ୍ଟି ସ୍  ଡି . ୱାଇ ଚନ୍ଦ୍ରଚୂ ଡ

✓

Q24 GA
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ  ବି ବୃ ତ୍ତି ଟି  ମି ଶ୍ର ଣକୁ  ଏକ ଯୌଗି କରୁ  ସଠି କ ଭାବେ ପୃ ଥକ କରେ?

A.  ଗୋଟି ଏ ମି ଶ୍ର ଣର ଉପାଦାନଗୁ ଡ଼ି କୁ  ଭୌତି କ ପ୍ର ଣାଳୀ ଦ୍ୱାରା ଅଲଗା
କରାଯାଇପାରି ବ

B.  ଗୋଟି ଏ ମି ଶ୍ର ଣ ଏକ ରାସାୟନି କ ପ୍ର ତି କ୍ରି  ୟା ଦ୍ୱାରା ସୃ ଷ୍ଟି  ହୋଇଥାଏ, କି ନ୍ତୁ ଏକ
ଯୌଗି କ ସେପରି  ହୋଇନଥାଏ

C.  ଏକ ମି ଶ୍ର ଣରେ ଏହାର ଉପାଦାନଗୁ ଡ଼ି କର ନି ର୍ଦ୍ଦିଷ୍ଟ ଅନୁ ପାତ ଥାଏ  

D.  ଗୋଟି ଏ ଯୌଗି କ ପଦାର୍ଥ  ନି ଜର ଉପାଦାନଗୁ ଡ଼ି କର ଗୁ ଣଧର୍ମ  ପ୍ର ଦର୍ଶ ନ କରେ

✓

Q25 GA
ଏପ୍ରି  ଲ 2026 ରେ ଓଡ଼ି ଶାର ଭୁ ବନେଶ୍ୱରରେ ଭାରତର ପ୍ର ଥମ ଉନ୍ନତ 3D ଚି ପ ପ୍ୟାକେଜିଂ
ୟୁ ନି ଟ ଆରମ୍ଭ ହୋଇଥି ଲା । ଏହି  ପ୍ର କଳ୍ପର ନାମ କ'ଣ ଅଟେ?

A.  ସି ଲି କନ ଇଣ୍ଟି ଗ୍ରେ ସନ ପ୍ୟାକେଜିଂ  ସଲ୍ୟୁ ସନସ

B.  ହେଟେରୋଜି ନି ଅସ ଇଣ୍ଟି ଗ୍ରେ ସନ ପ୍ୟାକେଜିଂ  ସଲ୍ୟୁ ସନସ

C.  ଆଡଭାନ୍ସ ଡ ସେମି କଣ୍ଡକ୍ଟର ପ୍ୟାକେଜିଂ  ଇନି ସି ଏଟି ଭ

D.  ଡି ଜି ଟାଲ ଚି ପ ଡେଭେଲପମେଣ୍ଟ ସଲ୍ୟୁ ସନସ

✓

Q26 GA
2025 ମସି ହାରେ ମୁ କ୍ତି ଲାଭ କରି ଥି ବା କେଉଁ  ଓଡ଼ି ଆ ଚଳଚ୍ଚି ତ୍ର  ଏହାର ପ୍ରା ରମ୍ଭି କ ସପ୍ତାହରେ
“ସର୍ବ କାଳୀନ ସର୍ବା ଧି କ ଆୟକାରୀ ଓଡ଼ି ଆ ଚଳଚ୍ଚି ତ୍ର ” ଭାବରେ ପରି ଗଣି ତ ହୋଇଥି ଲା ଏବଂ
ଏଥି ରେ ବାବୁ ଶାନ ମହାନ୍ତି  ଓ ଅର୍ଚ୍ଚିତା ସାହୁ  ମୁ ଖ୍ୟ ଭୂ ମି କାରେ ଅଭି ନୟ କରି ଥି ଲେ?

A.  ଚାରି ଧାମ

B.  ବୋଉ ବୁ ଟୁ  ଭୂ ତ

C.  ମୋ ବୋଉ ମୋ ଗାଁ

D.  ନାଦବି ନ୍ଦୁ
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✓

Q27 GA
ଭାରତର କାଜି ରଙ୍ଗା ଜାତୀୟ ଉଦ୍ୟାନ କେଉଁ  ପ୍ରା ଣୀ ପ୍ର ଜାତି  ସଂରକ୍ଷଣ ପାଇଁ  ପ୍ର ସି ଦ୍ଧ ଅଟେ?

A.  ମହାବଳ ବାଘ

B.  ଏକ ଶି ଙ୍ଘା ଗଣ୍ଡା

C.  ହି ମ କଲରାପତରି ଆ ବାଘ

D.  ଏସୀୟ ସିଂ ହ

✓

Q28 GA
ଚି ଲି କା ହ୍ର ଦର ଜଳ ଶେଷରେ କେଉଁ ଠାକୁ  ପ୍ର ବାହି ତ ହୋଇଥାଏ?

A.  ବଙ୍ଗୋପସାଗର

B.  ଆରବ ସାଗର

C.  ଭାରତ ମହାସାଗର

D.  ଲୋହି ତ ସାଗର

✓

Q29 GA
ଓଡ଼ି ଶାର ପି ପି ଲି  ସହର କେଉଁ  ପାରମ୍ପରି କ ହସ୍ତଶି ଳ୍ପ ପାଇଁ  ପ୍ର ସି ଦ୍ଧ ଅଟେ?

A.  ପଥରରେ କଳାକୃ ତି ର ଖୋଦନ

B.  ରୂ ପାର ତାରକସି  କାମ

C.  ଚାନ୍ଦୁ ଆ କାମ

D.  ପଟ୍ଟଚି ତ୍ର

✓

Q30 GA
ୱାର୍ଲ୍ଡ  ଇଣ୍ଟେଲେକଚୁ ଆଲ ପ୍ର ପେର୍ଟି ଅର୍ଗା ନାଇଜେସନ (WIPO) ଦ୍ୱାରା ପ୍ର କାଶି ତ 'ଗ୍ଲୋ ବାଲ
ଇନୋଭେସନ ଇଣ୍ଡେକ୍ସ (GII) 2025' ରେ, 139 ଟି  ଅର୍ଥ ନୀତି  ମଧ୍ୟରୁ  ଭାରତର ସାମଗ୍ରି  କ
ବି ଶ୍ୱସ୍ତରୀୟ ମାନ୍ୟତା କେତେ?

A.  28

B.  32

C.  38

D.  42

✓

Q31 GA
ଭାରତରେ ଘରୋଇ ବୈ ଦ୍ୟୁ ତି କ ସଂଯୋଗ ରେ ବ୍ୟବହୃ ତ ହେଉଥି ବା ଲାଇଭ ତାର ପାଇଁ
ନି ର୍ଦ୍ଦିଷ୍ଟ ରଙ୍ଗର ସଙ୍କେତ ହେଉଛି  _______ ।

A.  ସବୁ ଜ

B.  କଳା

C.  ଲାଲ

D.  ନୀଳ

✓

Q32 GA
2025 ରେ ବି ହାର ବି ଧାନସଭା ନି ର୍ବା ଚନରେ 89 ଟି  ଆସନ ଜି ତି  NDA ମଧ୍ୟରେ କେଉଁ
ରାଜନୈ ତି କ ଦଳ ସର୍ବା ଧି କ ଆସନ ପ୍ରା ପ୍ତ ଦଳ (single largest party) ଭାବେ
ପରି ଗଣି ତ ହୋଇଥି ଲା?

A.  ଭାରତୀୟ ଜନତା ପାର୍ଟି

B.  ଜନତା ଦଳ (ୟୁ ନାଇଟେଡ)

C.  ରାଷ୍ଟ୍ରୀୟ ଜନତା ଦଳ

D.  ଲୋକ ଜନଶକ୍ତି  ପାର୍ଟି (ରାମ ବି ଳାସ)

✓

Q33 GA
ଭାରତର ରୂ ପାନ୍ତରଣ ପାଇଁ  ନାଭି କୀୟ ଶକ୍ତି ର ସ୍ଥାୟୀ ଉପଯୋଗ ଏବଂ ଉନ୍ନତି  (SHANTI)
ବି ଧେୟକ, 2025 ___________ କୁ  ଏକୀକୃ ତ ଏବଂ ଆଧୁ ନି କୀକରଣ କରେ ।

A.  ନାଭି କୀୟ ଶକ୍ତି  ଚାଳି ତ ଯାନର ପ୍ର ଚଳନ

B.  ଭାରତର ନାଭି କୀୟ ଆଇନଗତ ରୂ ପରେଖ

C.  ନାଭି କୀୟ ଶକ୍ତି  ଉପରେ ସରକାରଙ୍କ ଦ୍ୱାରା ପରି ଚାଳି ତ ଗବେଷଣା

D.  ଆନ୍ତର୍ଜା ତୀୟ ଆଣବି କ ସହଯୋଗ ଚୁ କ୍ତି ନାମା

✓

Q34 GA
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ବି କଳ୍ପଟି  ସେହି  ସର୍ତ୍ତ କୁ  ସଠି କ ଭାବରେ ବର୍ଣ୍ଣ ନା କରେ, ଯାହା ଅଧୀନରେ
ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ ବର୍ଷ ରେ ପ୍ର ଦାନ କରାଯାଉଥି ବା ଅର୍ଜୁ ନ ପୁ ରସ୍କାର ସଂଖ୍ୟାର ନି ର୍ଦ୍ଧା ରି ତ ସୀମାକୁ
ଅତି କ୍ର ମ କରାଯାଇପାରି ବ?

A.  ପ୍ର ତ୍ୟେକ ଜାତୀୟ କ୍ରୀ ଡ଼ା ମହାସଂଘରୁ  ତି ନୋଟି ରୁ  ଅଧି କ ନାମାଙ୍କନ ପ୍ରା ପ୍ତ ହେଲେ

B.  ଯୁ ବ ବ୍ୟାପାର ଓ କ୍ରୀ ଡ଼ା ବି ଭାଗର ପ୍ର ଭାରୀ ମନ୍ତ୍ରୀଙ୍କ ଅନୁ ମୋଦନ କ୍ର ମେ ଏକ
ନି ର୍ଦ୍ଦିଷ୍ଟ ବର୍ଷ ରେ ଅଲି ମ୍ପି କ ଗେମ୍ସ  ଭଳି  ପ୍ର ତି ଯୋଗି ତାଗୁ ଡ଼ି କରେ ଭାରତୀୟ
କ୍ରୀ ଡ଼ାବି ତମାନଙ୍କ ପ୍ର ଦର୍ଶ ନ ହେଲେ

C.  ସ୍ୱଦେଶୀ କ୍ରୀ ଡ଼ା ସମେତ ପ୍ର ତ୍ୟେକ ବି ଭାଗରେ ଅତି  କମରେ ଦୁ ଇଟି  ପୁ ରସ୍କାର
ପ୍ର ଦାନ କରାଗଲେ

D.  ନି ର୍ଦ୍ଧା ରି ତ ସୀମା ବାହାରେ ବ୍ୟକ୍ତି ଗତ ଭାବେ ନାମାଙ୍କନ ପ୍ରା ପ୍ତ ହେଲେ

✓

Q35 GA
କେଉଁ  କାରକ ମୁ ଖ୍ୟତଃ ପୃ ଷ୍ଠ ସାମୁ ଦ୍ରି  କ ସ୍ରୋ ତ (surface ocean currents) କୁ
ପରି ଚାଳି ତ କରି ଥାଏ?

A.  ଭୂ ମି କମ୍ପ

B.  ପବନ

C.  ଆଗ୍ନେୟଗି ରି

D.  ସମୁ ଦ୍ର  ଗଭୀରତା

✓

Q36 GA
ଉଦ୍ଭି ଦ ଟି ସୁ ର ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ବୈ ଶି ଷ୍ଟ୍ୟ ବର୍ଜ୍ୟ ବସ୍ତୁ ସଂରକ୍ଷଣରେ ସହାୟକ ହୋଇଥାଏ?

A.  ଅତ୍ୟଧି କ ଜଳୀୟ ଅଂଶ

B.  ମୃ ତ କୋଷଗୁ ଡ଼ି କର ଉପସ୍ଥି ତି

C.  ଉଚ୍ଚ ଶର୍କ ରା ଅଂଶ

D.  କ୍ଲୋ ରୋଫି ଲ ର ଉପସ୍ଥି ତି  
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✓

Q37 GA
ଉତ୍ତର ସମତଳ ଅଞ୍ଚଳର ଭାବର ଅଞ୍ଚଳରେ ନଦୀ ବା ସ୍ରୋ ତଗୁ ଡ଼ି କ କାହିଁକି  ଅଦୃ ଶ୍ୟ
ହୋଇଯାଆନ୍ତି ?

A.  ଉଚ୍ଚ ବାଷ୍ପୀଭବନ ହାର

B.  ବାଲି ଆ ମୃ ତ୍ତି କା ଅବସ୍ଥା (Sandy soil conditions)

C.  ପଥର ଓ ପଥର ଢ଼ି ମାଗୁ ଡ଼ି କର ଅବକ୍ଷେପଣ (Deposition of rocks and
boulders)

D.  ନି ମ୍ନ  ବୃ ଷ୍ଟି ପାତ ସ୍ତର

✓

Q38 GA
କେଉଁ  ଭାରତୀୟ ଲେଖକ ଆଧୁ ନି କ ଭାରତୀୟ ସାହି ତ୍ୟରେ ଗୋଦାନ ପରି  ଉପନ୍ୟାସ
ମାଧ୍ୟମରେ ବାସ୍ତବବାଦର ପ୍ର ବର୍ତ୍ତ ନ ପାଇଁ  ସର୍ବା ଧି କ ପରି ଚି ତ?

A.  ମୁ ନଶୀ ପ୍ରେ ମଚନ୍ଦ

B.  ରବୀନ୍ଦ୍ରନାଥ ଟାଗୋର

C.  ଆର.କେ. ନାରାୟଣ

D.  ମୁ ଲ୍କ ରାଜ ଆନନ୍ଦ

✓

Q39 GA
ଭାରତୀୟ ସମ୍ବି ଧାନର କେଉଁ  ସମ୍ବି ଧାନ ସଂଶୋଧନ ଦ୍ୱାରା 6–14 ବର୍ଷ  ବୟସର ଶି ଶୁ ମାନଙ୍କ
ପାଇଁ  ମାଗଣା ଏବଂ ବାଧ୍ୟତାମୂ ଳକ ଶି କ୍ଷାକୁ  ଏକ ମୌଳି କ ଅଧି କାର ଭାବରେ ମାନ୍ୟତା
ଦି ଆଯାଇଛି ?

A.  42 ତମ ସଂଶୋଧନ

B.  62 ତମ ସଂଶୋଧନ

C.  76 ତମ ସଂଶୋଧନ

D.  86 ତମ ସଂଶୋଧନ

✓

Q40 GA
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ ଟି କୁ  ଆର୍ଥିକ ଭି ତ୍ତି ଭୂ ମି  ଅଧୀନରେ ବର୍ଗୀ କୃ ତ କରାଯାଇଛି ?

A.  ସ୍ୱାସ୍ଥ୍ୟ ସେବା

B.  ଶି କ୍ଷା ସୁ ବି ଧା

C.  ଯୋଗାଯୋଗ ପ୍ର ଣାଳୀ

D.  ପରି ମଳ ସେବା

English

✓

Q41 English

Complete the sentence with the most appropriate article:
The advancement of artificial intelligence has raised ethical questions regarding ______ use of
autonomous systems in warfare.
2229

A.  an

B.  the

C.  a

D.  no article needed

✓

Q42 English
Select the option that can be used as a one-word substitute for the underlined group of words.

The cruel treatment over long periods of time resulted in riots against the dictatorial rule.

A.  succor

B.  prosecution

C.  persecution

D.  stimulation
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✓

Q43 English
Select the most appropriate option that rectifies the spelling error in the given sentence.

The film’s interpretacion was subject to wide critical debate.

A.  Interpretation

B.  Interpretacin

C.  Interpretatoin

D.  Interpritation

✓

Q44 English
Select the option that expresses the given sentence in passive voice.

The legal team has been scrutinising every clause of the proposed international agreement.

A.  The legal team has scrutinised every clause.

B.  Every clause is being scrutinised by the legal team.

C.  The proposed international agreement was under scrutiny.

D.  Every clause of the proposed international agreement has been being scrutinised by the legal team.

✓

Q45 English
In the given question, a statement divided into different segments is given. Rearrange all the segments to form a coherent statement.

A) he decided to
B) take a break
C) after working nonstop
D) for five hours

A.  CDAB

B.  DABC

C.  DCAB

D.  ADBC

✓

Q46 English
Identify the antonym of the highlighted word in the sentence.
The witness gave a reluctant response when questioned by the lawyer.

A.  kind

B.  timid

C.  gentle

D.  eager
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✓

Q47 English
Sentences of a paragraph are given below in jumbled order. Arrange the sentences in the correct order to form a meaningful and coherent
paragraph.

P. As a result, many endangered species are now struggling to survive in fragmented ecosystems.
Q. Urban expansion and deforestation have drastically reduced natural habitats.
R. These environmental changes disrupt biodiversity and ecological balance.
S. Human activities have had a profound impact on wildlife across the globe.

A.  SQRP

B.  QSRP

C.  SRQP

D.  RQSP

✓

Q48 English
In the following sentence, a segment is given in capital letters. Select the most appropriate idiom to replace the capitalised words in the
sentence below.

Hard work and persistence always pay off EVENTUALLY, OR AFTER A LONG PERIOD.

A.  in black and white

B.  in the long run

C.  at sixes and sevens

D.  on thin ice

✓

Q49 English
Choose the option that can substitute the underlined idiom seamlessly.

Don’t let the cat out of the bag about the surprise party.

A.  reveal the secret

B.  lock the room

C.  hide the key

D.  spoil the fun

✓

Q50 English
Choose the correct indirect speech conversion of the sentence.
Direct speech: The teacher said to the students, “Do not waste your time.”

A.  The teacher advised the students not to waste their time.

B.  The teacher told the students not waste their time.

C.  The teacher said the students don’t waste time.

D.  The teacher requested the students that they should not waste time.
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✓

Q51 English
Select the most appropriate option to fill in the blank.

The teacher spoke _____ the importance of honesty during the morning assembly.

A.  from

B.  by

C.  about

D.  along

✓

Q52 English

Read the given passage and answer the following questions:

The internet has transformed the way people communicate worldwide. Through emails, messaging apps, and social media platforms, individuals
can connect instantly across continents. Businesses use the internet to reach global markets, conduct online transactions, and interact with
customers. Students and professionals access vast amounts of information for learning, research, and work. However, while the internet provides
numerous benefits, it also carries risks. Online misinformation, cyberbullying, and privacy concerns are common challenges. Overuse of digital
devices can affect mental health and reduce physical activity. Therefore, responsible and balanced internet usage is essential. Parents and
educators should guide young users, while governments should enforce cybersecurity measures. By using the internet wisely, people can
maximize its advantages, maintain social connections, and enhance knowledge without compromising safety or well-being.

What is the best title for the passage?

A.  Internet and Communication

B.  Privacy Issues Online

C.  Email Challenges

D.  Technology Addiction

✓

Q53 English
What is the main theme of the passage?

A.  Responsible internet use

B.  Video games are harmful

C.  Only businesses use the internet

D.  Internet is always negative

✓

Q54 English
What message can be inferred from the passage?

A.  One must avoid all forms of internet use

B.  Social media is addictive and should be banned

C.  Using the internet responsibly benefits society

D.  Emails are an outdated means of communication
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✓

Q55 English
Which fact is stated in the passage?

A.  Internet has no risks

B.  People can connect instantly online

C.  Internet replaces schools

D.  Businesses cannot use social media

✓

Q56 English
Choose the correct antonym of the word “excessive”.

A.  Rigid

B.  Serene

C.  Moderate

D.  Precise

✓

Q57 English
Select the option that is closest in meaning to the opposite of the highlighted word in the given sentence.

After hours of walking, he began to trudge along the muddy road.

A.  Stride

B.  Suffer

C.  Suspend

D.  Wander

✓

Q58 English
Choose the correct form of Simple Future Tense.

A.  I will call you as soon as I arrive.

B.  I will be calling you as soon as I arrive.

C.  I will have called you as soon as I arrive.

D.  I must call you as soon as I arrive.
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✓

Q59 English
Choose the option which best replaces the underlined phrase in the given sentence.
The rules seemed lacking a clear purpose or direction, changing frequently without explanation or logical justification.

A.  strategic

B.  arbitrary

C.  deliberate

D.  systematic

✓

Q60 English
Complete the sentence with a grammatically appropriate verb.

They had ______ the project due to unforeseen circumstances.3939

A.  abandons

B.  abandon

C.  abandoned

D.  to abandoning

Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
କୋଣାର୍କ  ସୂ ର୍ଯ୍ୟ  ମନ୍ଦି ର ଏକ ୟୁ ନେସ୍କୋ ବି ଶ୍ୱ ଐତି ହାସି କ କୀର୍ତ୍ତି ସ୍ଥଳ ଅଟେ ।

A.  The Konark Sun Temple is a UNESCO World Heritage Site.

B.  The Konark Sun Temple is a railway station.

C.  The Konark Sun Temple is a museum in Delhi.

D.  The Konark Sun Temple is a political building.

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ସେ ପ୍ର ତି ଦି ନ ସକାଳରେ ଚା' ପି ଅନ୍ତି  ।

A.  He drinks tea every morning.

B.  He drink tea every mornings.

C.  He is drinking tea on every morning.

D.  He drunk tea daily morning.

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଦେଶ ମଧ୍ୟରେ ଜାହାଜଗୁ ଡି କ ମହାସାଗର ଏବଂ ସମୁ ଦ୍ର  ଦେଇ ମାଲସାମଗ୍ରୀ  ପରି ବହନ ପାଇଁ  ବ୍ୟବହୃ ତ ହୁ ଏ ।

A.  Ships are used to transport goods safely across oceans and seas between countries.

B.  Ships is used to transport goods safely across oceans and seas between country.

C.  Ships are used to transport good safely across oceans and seas between countries.

D.  Ship are used transport goods safely across oceans and seas between countries.
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✓

Q64 Odia
ସେ ଟ୍ରେ ନ୍  ଧରି ବାକୁ  ______ ଆସି ଥି ଲେ।

A.  ସାମ୍ପ୍ରତି କ

B.  ବି ଳମ୍ବରେ

C.  ପରେ

D.  ଶେଷ

✓

Q65 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ ।

1930 ରୁ  1933 ମଧ୍ୟରେ ଭାରତର ପ୍ର ଥମ ପ୍ର ଧାନମନ୍ତ୍ରୀ ପଣ୍ଡି ତ ଜବାହରଲାଲ ନେହେରୁ ଙ୍କ ଦ୍ୱାରା ଲି ଖି ତ ସବୁ ଠାରୁ  ଉଲ୍ଲେଖନୀୟ କୃ ତି  ମଧ୍ୟରୁ  ଗୋଟି ଏ ହେଉଛି  "ଗ୍ଲି  ମ୍ପସେସ୍  ଅଫ୍  ୱାର୍ଲ୍ଡ  ହି ଷ୍ଟ୍ରି "। ଏହି
ପୁ ସ୍ତକଟି  ଭାରତର ବି ଭି ନ୍ନ ଜେଲରୁ  ନେହେରୁ  ତାଙ୍କ ଝି ଅ ଇନ୍ଦି ରା ଗାନ୍ଧୀଙ୍କୁ  ଲେଖି ଥି ବା 196 ଟି  ଚି ଠି ର ଏକ ସଂକଳନ । ଏହି  ଚି ଠି ଗୁ ଡ଼ି କ କେବଳ ଇତି ହାସର ପାଠ ଭାବରେ ନୁ ହେଁ  ବରଂ ମାନବ
ସଭ୍ୟତା, ସଂସ୍କୃତି  ଏବଂ ଚି ନ୍ତାଧାରାର ବି କାଶର ପରି ଚୟ ଭାବରେ ଉଦ୍ଦି ଷ୍ଟ ଥି ଲା। ନେହେରୁ , ତାଙ୍କର ବି ଶାଳ ଜ୍ଞାନ ଏବଂ ମାନବତା ପ୍ର ତି  ଗଭୀର ପ୍ରେ ମ ସହି ତ, ଏହି  ଚି ଠି ଗୁ ଡ଼ି କ ଜରି ଆରେ ବି ଶ୍ୱ
ଇତି ହାସକୁ  ଏପରି  ଭାବରେ ବ୍ୟାଖ୍ୟା କରି ଛନ୍ତି  ଯାହା ଉଭୟ ବ୍ୟକ୍ତି ଗତ ଏବଂ ସାର୍ବ ଜନୀନ ଥି ଲା। ଏହି  ପୁ ସ୍ତକଟି  ହଜାର ହଜାର ବର୍ଷ  ବ୍ୟାପି ଛି  - ମି ଶର, ମେସୋପୋଟାମି ଆ ଏବଂ ଭାରତର ପ୍ରା ରମ୍ଭି କ
ସଭ୍ୟତାରୁ  ଆରମ୍ଭ କରି  ଗ୍ରୀ ସ୍  ଏବଂ ରୋମର ମହାନ ସାମ୍ରା ଜ୍ୟ ପର୍ଯ୍ୟ ନ୍ତ, ଏବଂ ଆହୁ ରି  ମଧ୍ୟ ଇସଲାମର ଉତ୍ଥାନ, ୟୁ ରୋପୀୟ ନବଜାଗରଣ ଏବଂ ବିଂ ଶ ଶତାବ୍ଦୀ ପର୍ଯ୍ୟ ନ୍ତ ଆଧୁ ନି କ ବି ଶ୍ୱ ଘଟଣାବଳୀ
ପର୍ଯ୍ୟ ନ୍ତ।

ନେହେରୁ ଙ୍କ "ଗ୍ଲି  ମ୍ପସେସ୍  ଅଫ୍  ୱାର୍ଲ୍ଡ  ହି ଷ୍ଟ୍ରି " ଲେଖି ବାର ଉଦ୍ଦେଶ୍ୟ କେବଳ ଇନ୍ଦି ରାଙ୍କୁ  ଶି କ୍ଷା ଦେବା ନୁ ହେଁ  ବରଂ ବି ଶ୍ୱ ବି ଷୟରେ ଏକ ଏମି ତି  ଦୃ ଷ୍ଟି କୋଣର ପ୍ର ସାର କରି ବା ମଧ୍ୟ ଥି ଲା ଯାହା ଏକତା,
ପ୍ର ଗତି  ଏବଂ ଶାନ୍ତି  ଉପରେ ଗୁ ରୁ ତ୍ୱାରୋପ କରି ଥି ଲା। ସେ ବି ଶ୍ୱାସ କରୁ ଥି ଲେ ଯେ ଇତି ହାସ କେବଳ ଯୁ ଦ୍ଧ ଏବଂ ବି ଜୟର ଏକ ରେକର୍ଡ  ନୁ ହେଁ  ବରଂ ମାନବ ବି କାଶ ଏବଂ ସ୍ୱାଧୀନତା ଏବଂ ନ୍ୟାୟ ପାଇଁ
ସଂଘର୍ଷ ର ଏକ କାହାଣୀ । ଏହି  କାର୍ଯ୍ୟ କୁ  ଅନନ୍ୟ କରି ଥାଏ ନେହରୁ ଙ୍କ ଇତି ହାସ ପ୍ର ତି  ଦୃ ଷ୍ଟି କୋଣ |ସେ ରାଜନୈ ତି କ ଘଟଣାଗୁ ଡ଼ି କୁ  ସାମାଜି କ ପରି ବର୍ତ୍ତ ନ, ବୈ ଜ୍ଞାନି କ ଆବି ଷ୍କାର ଏବଂ ଦାର୍ଶ ନି କ
ଚି ନ୍ତାଧାରା ସହି ତ ସଂଯୋଗ କରନ୍ତି । ତାଙ୍କର ବର୍ଣ୍ଣ ନା ଶୈ ଳୀ ଆକର୍ଷ ଣୀୟ, ଐତି ହାସି କ ତଥ୍ୟକୁ  ନୈ ତି କ ପ୍ର ତି ଫଳନ ସହି ତ ମି ଶ୍ର ଣ କରେ। ଚି ଠି ଗୁ ଡ଼ି କ ନେହରୁ ଙ୍କ ଗଭୀର ମାନବବାଦ ଏବଂ
ଆନ୍ତର୍ଜା ତୀୟତାକୁ  ମଧ୍ୟ ପ୍ର କାଶ କରି ଥାଏ ; ସେ ସମସ୍ତ ଜାତି କୁ  ଗୋଟି ଏ ମାନବ ପରି ବାରର ଅଂଶ ଭାବରେ ଦେଖୁ ଥି ଲେ ଏବଂ ପ୍ରା ୟତଃ ଅତ୍ୟାଚାର କି ମ୍ବା ସାମ୍ରା ଜ୍ୟବାଦ ବି ନା ଏକ ବି ଶ୍ୱ ପାଇଁ  ତାଙ୍କର
ଆଶା ପ୍ର କାଶ କରି ଥି ଲେ।

କାରାଗାର କାନ୍ଥ ପଛରୁ  ଲି ଖି ତ, ପୁ ସ୍ତକଟି  ନେହରୁ ଙ୍କ ବୌଦ୍ଧି କ ସ୍ଥି ରତା ଏବଂ ଆଶାବାଦୀ ଆତ୍ମାର ଏକ ପ୍ର ମାଣ । ତାଙ୍କର ବନ୍ଦୀତ୍ୱ ସତ୍ତ୍ୱେ, ସେ ଜ୍ଞାନ ଏବଂ କୌତୁ ହଳରେ ପରି ପୂ ର୍ଣ୍ଣ  ମାନବ ସଭ୍ୟତାର ଏକ
ବ୍ୟାପକ ଦୃ ଶ୍ୟ ସୃ ଷ୍ଟି  କରି ବାରେ ସଫଳ ହୋଇଥି ଲେ । ବି ଶ୍ୱ ଇତି ହାସର ଝଲକ କେବଳ ଐତି ହାସି କ ଲେଖା ନୁ ହେଁ  ବରଂ ରାଜନୈ ତି କ ଦର୍ଶ ନ ଏବଂ ସାହି ତ୍ୟର ମଧ୍ୟ ଏକ ଉଦାହରଣ ଅଟେ।

"ଗ୍ଲି  ମ୍ପସେସ୍  ଅଫ୍  ୱାର୍ଲ୍ଡ  ହି ଷ୍ଟ୍ରି " ନେହେରୁ ଙ୍କ ଦ୍ୱାରା ଲି ଖି ତ କେତୋଟି  ଚି ଠି ର ଏକ ସଂକଳନ ?

A.  150

B.  196

C.  210

D.  175

✓

Q66 Odia
"ଗ୍ଲି  ମ୍ପସେସ୍  ଅଫ୍  ୱାର୍ଲ୍ଡ  ହି ଷ୍ଟ୍ରି " ରେ ଚି ଠି ଗୁ ଡ଼ି କ କାହାକୁ  ସମ୍ବୋଧି ତ କରାଯାଇଥି ଲା?

A.  ମହାତ୍ମା ଗାନ୍ଧୀ

B.  କମଳା ନେହେରୁ

C.  ଇନ୍ଦି ରା ଗାନ୍ଧୀ

D.  ସରୋଜି ନୀ ନାଇଡୁ

✓

Q67 Odia
ଏହି  ପୁ ସ୍ତକରେ ସଂକଳି ତ ଚି ଠି ଗୁ ଡ଼ି କ କେଉଁ  ବର୍ଷ ରେ ନେହେରୁ  ଲେଖି ଥି ଲେ?

A.  1920–1923

B.  1930–1933

C.  1942–1945

D.  1919–1921
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✓

Q68 Odia
"ଗ୍ଲି  ମ୍ପସେସ୍  ଅଫ୍  ୱାର୍ଲ୍ଡ  ହି ଷ୍ଟ୍ରି " ଲେଖି ବାରେ ନେହେରୁ ଙ୍କ ମୁ ଖ୍ୟ ଲକ୍ଷ୍ୟ କ'ଣ ଥି ଲା?

A.  ରାଜନୀତି  ବି ଜ୍ଞାନ ପଢ଼ାଇବା

B.  ତାଙ୍କ ଝି ଅକୁ  ବି ଶ୍ୱ ଇତି ହାସ ଏବଂ ମାନବ ସଭ୍ୟତା ବି ଷୟରେ ଶି କ୍ଷା ଦେବା

C.  ବ୍ରି  ଟି ଶ ଶାସନକୁ  ସମାଲୋଚନା କରି ବା

D.  ଭାରତର ସ୍ୱାଧୀନତା ସଂଗ୍ରା ମକୁ  ଦଲି ଲ କରି ବା

✓

Q69 Odia
ପୁ ସ୍ତକରେ ନେହେରୁ ଙ୍କ ଇତି ହାସ ପ୍ର ତି  ଦୃ ଷ୍ଟି କୋଣକୁ  ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ସର୍ବୋ ତ୍ତମ ଭାବରେ ବର୍ଣ୍ଣ ନା କରେ?

A.  କେବଳ ଯୁ ଦ୍ଧ ଏବଂ ସାମ୍ରା ଜ୍ୟ ଉପରେ କେନ୍ଦ୍ରି ତ

B.  ସାମାଜି କ, ସାଂସ୍କୃତି କ ଏବଂ ବୈ ଜ୍ଞାନି କ ବି କାଶ ଅନ୍ତର୍ଭୁ କ୍ତ

C.  ଭାରତୀୟ ଇତି ହାସ ପର୍ଯ୍ୟ ନ୍ତ ସୀମି ତ

D.  ସମ୍ପୂ ର୍ଣ୍ଣ  ପୌରାଣି କ କାହାଣୀ ଉପରେ ଆଧାରି ତ

✓

Q70 Odia
"ଊଣା ହି ଡ ଯେଉଁ ଠି , ପାଣି  ଗଡେ ସେଇଠି "- ଏହି  ଲୋକୋକ୍ତି ର ଠି କ୍  ଅର୍ଥ  କଣ ?

A.  ଯେଉଁ ଠି  ପାଣି  ଥାଏ,ସେଠି  ହି ଡ ଭାଙ୍ଗି ଯାଏ ।

B.  ଦୁ ର୍ବ ଳତା ପରାଜୟର କାରଣ ।

C.  ପାଣି  ସବୁ ଠାରେ ସମାନ ଭାବେ ବହେ ।

D.  ଶକ୍ତି ଶାଳୀ ଲୋକ ସବୁ ଠାରେ ଜି ତନ୍ତି  ।

✓

Q71 Odia
ଯୁ ଦ୍ଧରେ 'ଜୟ' ପରେ ________ ର ସମ୍ଭାବନା ମଧ୍ୟ ଥାଏ।
(ନି ମ୍ନ ରେ ପ୍ର ଦତ୍ତ ଶବ୍ଦ ମଧ୍ୟରୁ  ସଠି କ ଶବ୍ଦ ବ୍ୟବହାର କରି  ଶୂ ନ୍ୟସ୍ଥାନ ପୂ ରଣ କର)

A.  ହାର୍

B.  ବି ଫଳତା

C.  ପରାଜୟ

D.  କ୍ଷତି

✓

Q72 Odia
'ହି ମାଳୟ ପୃ ଥି ବୀର ଉଚ୍ଚତମ ଶୃ ଙ୍ଗ' ଏଠାରେ 'ଉଚ୍ଚତମ' କେଉଁ  ପ୍ର କାରର ବି ଶେଷଣ ଭାବେ ପରି ଗଣି ତ?

A.  ପୂ ରଣବାଚକ ବି ଶେଷଣ

B.  ତୁ ଳନାତ୍ମକ ବି ଶେଷଣ

C.  ବି ଧେୟ ବି ଶେଷଣ

D.  ଅବସ୍ଥାବାଚକ ବି ଶେଷଣ
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✓

Q73 Odia
‘ସ୍ଵର୍ଗ କୁ  ବତୀ ଦେବା’- ରୂ ଢ଼ି ଟି ର ଅର୍ଥ  କଣ?

A.  ପାଗ ବାନ୍ଧି ବା

B.  ସ୍ତ୍ରୀ ରୂ ପ ଧାରଣ କରି ବା

C.  ବଂଶ ରକ୍ଷା କରି ବା

D.  ହାତ ଗୋଡ଼ ବାନ୍ଧି ଦେବା

✓

Q74 Odia
ନି ମ୍ନୋ କ୍ତରେ ଥି ବା ପଦମାନଙ୍କ ମଧ୍ୟରୁ  କେଉଁ ଟି  କ୍ରି  ୟା ପଦ ବାଛ ।

A.  ଭାତ

B.  ଅନ୍ଧାର

C.  ସୁ ନ୍ଦର

D.  ଦେବା

✓

Q75 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  ତଦ୍ଭବ ଶଦ୍ଦ କେଉଁ ଟି  ?

A.  ଆଇଁ ଷ

B.  ପି ସ୍ତଲ

C.  ବୋତଲ

D.  ବାସନ

Computer

✓

Q76 Computer
ଇଲେକଟ୍ରୋ ନି କ କମ୍ପ୍ୟୁ ଟରଗୁ ଡ଼ି କ ବହୁ ଳ ଭାବରେ ଉପଲବ୍ଧ ହେବା ପୂ ର୍ବ ରୁ , ଦ୍ରୁ ତ ଗାଣି ତି କ
ଗଣନା ପାଇଁ  ବ୍ୟବହୃ ତ ପ୍ରା ରମ୍ଭି କ ଜ୍ଞାତ ଉପକରଣ ମଧ୍ୟରୁ  ଆବାକସ ଅନ୍ୟତମ ଥି ଲା ।
ପ୍ରା ଚୀନ ଇତି ହାସରେ ଆବାକସ ମୁ ଖ୍ୟତଃ କେଉଁ  ମୁ ଖ୍ୟ ଉଦ୍ଦେଶ୍ୟ ସାଧନ କରୁ ଥି ଲା?

A.  ଲୋକଙ୍କୁ  ଗଣି ବା ଏବଂ ହି ସାବ କରି ବାରେ ସାହାଯ୍ୟ କରି ବା ପାଇଁ  ।

B.  ଡକ୍ୟୁ ମେଣ୍ଟ ଏବଂ ଇମେଜକୁ  ଶୀଘ୍ର  ପ୍ରି  ଣ୍ଟ କରି ବା ପାଇଁ  ।

C.  ପ୍ର ଚୁ ର ପରି ମାଣର ସ୍ଥାୟୀ ଡାଟାକୁ  ଷ୍ଟୋର କରି ବା ପାଇଁ  ।

D.  ତାର୍କିକ ନି ଷ୍ପତ୍ତି ଗୁ ଡ଼ି କୁ  ସ୍ୱୟଂକ୍ରି  ୟ କରି ବା ପାଇଁ  (ଯେପରି କି  'if-then') ।

✓

Q77 Computer
MS ୱାର୍ଡ ରେ ଡକ୍ୟୁ ମେଣ୍ଟ ଖୋଲି ବା ବି ଷୟରେ ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ  ବି ବୃ ତି  ସଠି କ
ଅଟେ?

A.  ଡକ୍ୟୁ ମେଣ୍ଟ କେବଳ ଡେସ୍କଟପରୁ  ଖୋଲାଯାଇପାରି ବ, ଅନ୍ୟ ଫୋଲଡରରୁ  ନୁ ହେଁ  ।

B.  MS ୱାର୍ଡ  ଲୋକାଲ ଷ୍ଟୋରେଜ, କ୍ଲା ଉଡ ଷ୍ଟୋରେଜ କି ମ୍ବା ରି ସେଣ୍ଟ ଡକ୍ୟୁ ମେଣ୍ଟ
ଖୋଲି ବା ପାଇଁ  ଅନୁ ମତି  ଦି ଏ ଏବଂ ଅନସେଭ ଫାଇଲଗୁ ଡି କ ରି ଷ୍ଟୋର କରି ବାରେ ମଧ୍ୟ
ସାହାଯ୍ୟ କରେ ।

C.  ଏକାସାଙ୍ଗରେ ଏକାଧି କ ଡକ୍ୟୁ ମେଣ୍ଟ ଖୋଲି ବା ପାଇଁ  MS ୱାର୍ଡ  କୌଣସି  ସୁ ବି ଧା
ପ୍ର ଦାନ କରେ ନାହିଁ ।

D.  କୌଣସି  ନୂ ତନ ଡକ୍ୟୁ ମେଣ୍ଟ ଖୋଲି ବା ପୂ ର୍ବ ରୁ  ଖୋଲାଥି ବା ଡକ୍ୟୁ ମେଣ୍ଟ ବନ୍ଦ ରହି ବା
ଆବଶ୍ୟକ ।

✓

Q78 Computer
Which option is used to open an existing spreadsheet in MS Excel
2021?

A.  File → New

B.  File → Open

C.  Insert → Open

D.  View → File

✓

Q79 Computer
Which shortcut key inserts a new slide quickly in PowerPoint 2021?

A.  Ctrl + N

B.  Ctrl + M

C.  Ctrl + Shift + N

D.  Ctrl + S
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✓

Q80 Computer
What is meant by E-Mail?

A.  Easy Mail

B.  Express Mail

C.  Electronic Mail

D.  Electronic Message

✓

Q81 Computer
ଇଣ୍ଟରନେଟ ଏବଂ ୱାର୍ଲ୍ଡ  ୱାଇଡ ୱେବ ମଧ୍ୟରେ ସଠି କ ସମ୍ପର୍କ  କ’ଣ?

A.  ସେଗୁ ଡି କ ସମ୍ପୂ ର୍ଣ୍ଣ  ସମାନ ଅଟେ ।

B.  ୱେବ ହେଉଛି  ଇଣ୍ଟରନେଟର ଏକ ଅଂଶ ଯାହା ସୂ ଚନା ଆକ୍ସେସ୍  କରି ବା ପାଇଁ
ବ୍ରା ଉଜର ବ୍ୟବହାର କରେ ।

C.  ଇଣ୍ଟରନେଟ ୱେବର ଏକ ଅଂଶ ଅଟେ ।

D.  ଇଣ୍ଟରନେଟ ପ୍ରୋ ଟୋକଲ ବ୍ୟବହାର ନକରି  ୱେବ କାମ କରେ ।

✓

Q82 Computer
MS ଏକ୍ସେଲ 2007 ରେ ଆମେ କେଉଁ  ଟ୍ୟାବ ଅଧୀନରେ ଏକ ପାରାଗ୍ରା ଫର ଟେକ୍ସଟକୁ
ଫର୍ମା ଟ କରି ପାରି ବା?

A.  Page Layout ଟ୍ୟାବ

B.  View ଟ୍ୟାବ

C.  Insert ଟ୍ୟାବ

D.  Home ଟ୍ୟାବ

✓

Q83 Computer
MS ୱି ଣ୍ଡୋଜ 10 ରେ ଟାସ୍କବାରରେ ପି ନ ହୋଇଥି ବା ଆପ୍ଲି  କେସନ୍ ‌କୁ  କେଉଁ  ପଦ୍ଧତି  ଶୀଘ୍ର
ଖୋଲି ବାକୁ  ଅନୁ ମତି  ଦି ଏ?

A.  ଟାସ୍କବାରରେ ଆପ୍ଲି  କେସନର ସ୍ଥି ତି  ଅନୁ ଯାୟୀ ୱି ଣ୍ଡୋଜ କୀ + ନମ୍ବର ପ୍ରେ ସ କରି ବା ।

B.  ଡେସ୍କଟପରେ ରାଇଟ-କ୍ଲି  କ କରି ବା ଏବଂ କଣ୍ଟେକ୍ସଟ ମେନୁ ରୁ  ଆପ୍ଲି  କେସନ ସି ଲେକ୍ଟ
କରି ବା ।

C.  ଫାଇଲ୍  ଏକ୍ସପ୍ଲୋ ରର ଓପନ କରି ବା ଏବଂ ଆପ୍ଲି  କେସନ୍ ‌ର ଏକଜି କ୍ୟୁ ଟେବୁ ଲ
ଫାଇଲ ( executable file) ପର୍ଯ୍ୟ ନ୍ତ ନେଭି ଗେଟ କରି ବା ।

D.  କଣ୍ଟ୍ରୋଲ ପ୍ୟାନେଲ ବ୍ୟବହାର କରି ବା ଏବଂ 'Programs and Features'
ଚୟନ କରି ବା ।

✓

Q84 Computer
What is the primary function of the Alt + Tab keyboard shortcut in
Windows?

A.  Open the Task Manager

B.  Switch between open applications

C.  Delete a selected file

D.  Insert a new line in a document

✓

Q85 Computer
MS Excel runs on which of the following operating systems?

i. Windows
ii. macOS
iii. Android
iv. iOS

A.  i, ii, iii and iv

B.  Only i, iii and iv

C.  Only i, ii and iii

D.  Only ii, iii and iv

✓

Q86 Computer
Which key allows you to exit a running slide show at any time in MS
PowerPoint?

A.  Escape (Esc)

B.  Enter

C.  Shift

D.  Ctrl + Q

✓

Q87 Computer
ଏକ ଭି ନ୍ନ ଫାଇଲର କପି କୁ  ପାୱାର ପଏଣ୍ଟ ସ୍ଲା ଇଡରେ ଭର୍ତ୍ତି କରି ବାର ଅର୍ଥ  କ'ଣ?

A.  କପି

B.  ଏମ୍ବେଡ

C.  ଇନସର୍ଟ

D.  କମେଣ୍ଟ

✓

Q88 Computer
A user wants to apply a formula to a specific cell in Excel that refers
to data in another part of the worksheet. Which of the following best
describes how Excel identifies the correct location of that data?

A.  By using the worksheet name

B.  By using the cell address made of column and row reference

C.  By matching the colour of the cell

D.  By the order in which the cells are entered
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✓

Q89 Computer
MS-ୱାର୍ଡ  ରେ ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ ପେଜ ନମ୍ବରକୁ  ଯି ବା ପାଇଁ  ବ୍ୟବହୃ ତ କମାଣ୍ଡଟି  କଣ ଅଟେ?

A.  Ctrl+P

B.  Ctrl+R

C.  Ctrl+G

D.  Ctrl+A

✓

Q90 Computer
What is the function of the Control Unit in a CPU?

A.  Perform arithmetic operations

B.  Store data

C.  Direct operation of processor

D.  Input data

Reasoning

✓

Q91 Reasoning
C, A, T, F, I, S ଏବଂ H ଏକ ବୃ ତ୍ତାକାର ଟେବୁ ଲ ଚାରି ପାଖରେ କେନ୍ଦ୍ର ଆଡ଼କୁ  ମୁ ହଁ  କରି
ବସି ଛନ୍ତି  । T ଙ୍କ ର ଠି କ୍  ବାମ ପାର୍ଶ୍ୱ ରେ ଏବଂ S ର ଠି କ ଡାହାଣ ପାର୍ଶ୍ୱ ରେ F ବସି ଛନ୍ତି  । ଉଭୟ
C ଏବଂ H ଙ୍କର ଜଣେ ନି କଟତମ ପଡ଼ୋଶୀ ହେଉଛନ୍ତି  I । H ହେଉଛନ୍ତି  T ର ନି କଟତମ
ପଡ଼ୋଶୀ । C ର ଠି କ ଡାହାଣ ପାର୍ଶ୍ୱ ରେ କି ଏ ବସି ଛନ୍ତି ?

A.  A

B.  F

C.  S

D.  T

✓

Q92 Reasoning
ଜଣେ ବାଳକଙ୍କ ପାଖରେ ବସି ଥି ବା ଜଣେ ବ୍ୟକ୍ତି  ବାଳକଟି  ବି ଷୟରେ କହି ଲେ, "ସେ ମୋ
ବାପାଙ୍କ ଏକମାତ୍ର  ଝି ଅଙ୍କ ପୁ ଅ ।" ସେହି  ବ୍ୟକ୍ତି ଟି  ସମ୍ପର୍କ ରେ ପୁ ଅର କ'ଣ ହେବେ?

A.  ପୁ ଅ

B.  ମା'ଙ୍କ ଭାଇ

C.  ମା'ଙ୍କ ବାପା

D.  ବାପା

✓

Q93 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ ପ୍ର ଦତ୍ତ ଅନୁ କ୍ର ମରେ ପ୍ର ଶ୍ନ  ଚି ହ୍ନ (?) ସ୍ଥାନରେ କ'ଣ ରହି ବା
ଉଚି ତ?
BIX WDS RYN MTI ?

A.  HOD

B.  HDO

C.  HDR

D.  HRD

✓

Q94 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ WISH ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ ଉପାୟରେ SEVK ସହି ତ
ସମ୍ପର୍କିତ । OAYN ସେହି  ସମାନ ଉପାୟରେ KWBQ ସହି ତ ସମ୍ପର୍କିତ । ସମାନ ତର୍କ
ଅନୁ ସାରେ ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ସହି ତ GSET ସମ୍ପର୍କିତ?

A.  DNHV

B.  BOGX

C.  COHW

D.  BPIV

✓

Q95 Reasoning
ସାତଟି  ବାକ୍ସ Q, R, W, T, E, U ଏବଂ Y କୁ  ଗୋଟି ଏ ଉପରେ ଅନ୍ୟଟି  ରଖାଯାଇଛି  କି ନ୍ତୁ
ସମାନ କ୍ର ମରେ ରଖି ବା ଜରୁ ରୀ ନୁ ହେଁ  ।
Y କୁ  ନି ମ୍ନ ରୁ  ଦ୍ୱି ତୀୟ ସ୍ଥାନରେ ରଖାଯାଇଛି  । Y ଓ U ମଧ୍ୟରେ କେବଳ ତି ନୋଟି  ବାକ୍ସ
ରଖାଯାଇଛି  । Y ତଳେ କୌଣସି  ଏକ ସ୍ଥାନରେ E କୁ  ରଖାଯାଇଛି  । U ଓ T ମଧ୍ୟରେ କେବଳ
W କୁ  ରଖାଯାଇଛି  । U ଉପରେ କୌଣସି  ଏକ ସ୍ଥାନରେ Q କୁ  ରଖାଯାଇଛି  ।
W ଉପରେ କେତୋଟି  ବାକ୍ସ ରଖାଯାଇଛି  ?

A.  1

B.  2

C.  3

D.  4
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✓

Q96 Reasoning
ଯଦି  ‘+’ ଓ ‘−’ ପରସ୍ପର ମଧ୍ୟରେ ଅଦଳବଦଳ ହୁ ଏ ଏବଂ ‘×’ ଓ ‘÷’ ପରସ୍ପର ମଧ୍ୟରେ
ଅଦଳବଦଳ ହୁ ଏ ତେବେ ନି ମ୍ନୋ କ୍ତ ସମୀକରଣରେ (?) ସ୍ଥାନରେ କ'ଣ ରହି ବ?

44 ÷ 3 + 72 × 12 − 6 = ?

A.  111

B.  129

C.  107

D.  132

✓

Q97 Reasoning
ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ କୋଡ ଭାଷାରେ 'HLVD' କୁ  '82' ଭାବରେ ଏବଂ 'YQSU' କୁ  '46' ଭାବରେ
କୋଡ କରାଯାଇଛି  । ଦି ଆଯାଇଥି ବା କୋଡ ଭାଷାରେ 'KILE' ପାଇଁ  କୋଡ କ'ଣ ହେବ?

A.  84

B.  87

C.  91

D.  96

✓

Q98 Reasoning
ପ୍ର ଦତ୍ତ ବି ବୃ ତ୍ତି  ଏବଂ ନି ଷ୍କର୍ଷ ଗୁ ଡ଼ି କୁ  ଧ୍ୟାନର ସହ ପଢ଼ନ୍ତୁ । ବି ବୃ ତ୍ତି ରେ ଦି ଆଯାଇଥି ବା ସୂ ଚନା
ସତ୍ୟ ବୋଲି  ଧରି ନି ଅନ୍ତୁ, ଯଦି ଓ ଏହା ସାଧାରଣ ଜ୍ଞାତ ତଥ୍ୟଠାରୁ  ଭି ନ୍ନ ଜଣାପଡେ, ତେବେ
କେଉଁ  ନି ଷ୍କର୍ଷ ଗୁ ଡ଼ି କ ଯୁ କ୍ତି ଯୁ କ୍ତ ଭାବେ ବି ବୃ ତ୍ତି ରୁ  ଅନୁ ସରଣ କରୁ ଛି  ତାହା ନି ଷ୍ପତ୍ତି  କରନ୍ତୁ।

ବି ବୃ ତ୍ତି  :
ସମସ୍ତ ଛାତ୍ର ଛାତ୍ରୀ  ବାଳି କା ଅଟନ୍ତି  ।
କି ଛି  ବାଳି କା ବାଳକ ଅଟନ୍ତି  ।

ନି ଷ୍କର୍ଷ  :
(I) ସମସ୍ତ ଛାତ୍ର ଛାତ୍ରୀ  ବାଳକ ଅଟନ୍ତି  ।
(II) କି ଛି  ଛାତ୍ର ଛାତ୍ରୀ  ବାଳକ ଅଟନ୍ତି  ।2

A.  କେବଳ ନି ଷ୍କର୍ଷ  (I) ଅନୁ ସରଣ କରେ ।

B.  କେବଳ ନି ଷ୍କର୍ଷ  (II) ଅନୁ ସରଣ କରେ ।

C.  ଉଭୟ ନି ଷ୍କର୍ଷ  (I) ଏବଂ (II) ଅନୁ ସରଣ କରେ ।

D.  କୌଣସି  ନି ଷ୍କର୍ଷ  (I) କି ମ୍ବା (II) ଅନୁ ସରଣ କରେ ନାହିଁ ।

✓

Q99 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଅନୁ ସାରେ, ନି ମ୍ନ ଲି ଖି ତ ଚାରୋଟି  ଅକ୍ଷର-ସମୂ ହ ଯୋଡି  ମଧ୍ୟରୁ
ତି ନୋଟି  ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ ପଦ୍ଧତି ରେ ସମାନ ଏବଂ ଏକ ଗୋଷ୍ଠୀ ତି ଆରି  କରନ୍ତି  । ସେହି
ଗୋଷ୍ଠୀରେ ଅନ୍ତର୍ଭୁ କ୍ତ ହେଉନଥି ବା ଅକ୍ଷର-ସମୂ ହଟି  କେଉଁ ଟି  ଅଟେ?
(ବି .ଦ୍ର  : ଏହି  ଅସାମଞ୍ଜସ୍ୟ ଯୋଡି ଟି  ଅକ୍ଷର-ସମୂ ହରେ ଥି ବା ବ୍ୟଞ୍ଜନବର୍ଣ୍ଣ /ସ୍ୱରବର୍ଣ୍ଣ ର ସଂଖ୍ୟା
କି ମ୍ବା ସେଗୁ ଡ଼ି କର ସ୍ଥାନ ଉପରେ ଆଧାରି ତ ନୁ ହେଁ  ।)

A.  PR-TW

B.  CE-GI

C.  KM-OQ

D.  IK-MO

✓

Q100 Reasoning
ଶବ୍ଦ EPIDERM ର ପ୍ର ତ୍ୟେକ ସ୍ୱରବର୍ଣ୍ଣ କୁ  ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମରେ ଏହାର ଠି କ
ପରବର୍ତ୍ତୀ  ଅକ୍ଷରରେ ପରି ବର୍ତ୍ତ ନ କରାଯାଏ ଏବଂ ପ୍ର ତ୍ୟେକ ବ୍ୟଞ୍ଜନ ବର୍ଣ୍ଣ କୁ  ଇଂରାଜୀ
ବର୍ଣ୍ଣ ମାଳା କ୍ର ମରେ ଏହାର ଠି କ ପୂ ର୍ବ ବର୍ତ୍ତୀ  ଅକ୍ଷରରେ ପରି ବର୍ତ୍ତ ନ କରାଯାଏ । ଏହି ପରି  ଗଠି ତ
ନୂ ତନ ଅକ୍ଷର ଗୋଷ୍ଠୀରେ କେତୋଟି  ଅକ୍ଷର ଠି କ ଦୁ ଇଥର ରହି ବ?

A.  0

B.  1

C.  2

D.  3
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